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This guide provides editors of SFF TA TWG documents with supplementary information to aid in the creation
of new documents and in the revision of existing documents. It describes the content that is included in
each section of an SFF TA TWG specification and is best used in conjunction with the SFF TA TWG document
template. Questions about the content of this document should be directed to the SNIA Technical Council
Managing Director at tcmd@snia.org.
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1 Overview
This document provides informational text that is intended to guide editors of SFF TA TWG documents.
Content applies to editors creating new SFF TA TWG documents and editors revising existing documents.
This document is split into separate sections. Some sections apply to SFF TA TWG documents in general,
and some apply to connector specifications specifically.

2 Common Document Elements
The SFF TA TWG Document Template includes an Intellectual Property statement. This statement should
be included in all SFF TA TWG Specifications (SFF-#### or SFF-TA-####). It does not apply to
Information (INF) or Reference (REF) documents and therefore should not be included. Note that legacy
Information and Reference documents may start with the SFF designation (SFF-####) even though they
are not specifications and therefore should not include the Intellectual Property statement. If the
Intellectual Property statement is included in any document, it is to appear at the top of page 2 and is to
remain unchanged.
The subsections listed below apply to all SFF TA TWG Specifications (SFF documents), Information
documents (INF), and Reference documents (REF). The following sections are included on page 2 in the
SFF Document Template (after the Intellectual Property statement, if applicable) and are to remain
unchanged:
•
•
•

Copyright
Disclaimer
Foreword

2.1 Guidelines for Style: Figures, Tables, and Formatting
Refer to the SFF TA TWG Style Guide for style information pertaining figures, tables, and formatting.

2.2 Guide to Using the SFF Document Template
The SFF TA TWG Document Template contains several subsections. The following information applies to
each of these sections. Editor’s notes are included throughout the template and are shown in green text.

2.3 Revision History
Revision history tracking (document number, date, and a summary of the changes since the last version)
is maintained for all draft and published revisions of documents. The date reflects the date the draft or
published version is posted. Refer to the SFF TA TWG Process Guide for more information. Upon publication,
the changes through all the drafts are condensed into one heading for the major/minor revision listed in
the history. For example, drafts 1.3.1, 1.3.2, and 1.3.3 get condensed into one heading for 1.4 once
published. Duplicate or insignificant revision history entries may be omitted when appropriate.

2.4 Scope
The document scope lists the document’s contents; e.g. connector overview, mechanical description,
performance testing requirements, implementation guidelines, etc. Edit this section as needed.

2.5 References and Conventions
2.5.1 Industry Documents
This section lists other documents specifically identified within the body of the SFF document. Referenced
documents are to be listed in alphanumeric order by alphanumeric designation (e.g. INCITS 478, REF-TA1011, etc.). The document title should also be included following the designation. Refer to the SFF
Document Template for formatting guidelines.
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2.5.2 Sources
This section identifies the sources associated with each of the industry documents referenced in the
previous section. Sources are listed in the template for the most frequently referenced documents in the
SFF Document Template. If there are no documents listed that are associated with a particular source, that
source should be deleted. If a source is not listed for a referenced industry document, it should be added,
following the format provided in the SFF Document Template.
2.5.3 Conventions
The SFF TA TWG Document Template lists conventions, which are identified by the following categories:
•
•
•
•

Order of precedence
Lists
Dimensioning conventions
Numbering conventions

Any of these subsections that do not apply to the document should be deleted. Note: it is very unlikely that
order or precedence would ever be deleted.

2.6 Keywords, Acronyms, and Definitions
This section lists keywords, acronyms, and definitions used throughout the document. Acronyms and
definitions may be modified as needed, and those not listed in the SFF TA TWG Document Template should
be added to the appropriate subsection. Keywords, acronyms, and definitions not relevant to the
specification should be removed.

2.7 Guidelines for Converting to Newer Template Versions
When upgrading older SFF TA TWG documents to the newer template, it is recommended that the template
upgrade take place prior to revising any of the content (i.e., do not Track Changes during these steps).
The editor is strongly advised to copy document content into the template opposed to trying to recreate
the template.
The following guidelines are provided to assist the editor when converting to the new template. Note that
deviations to these guidelines are acceptable to preserve section numbers, table numbers, etc. that are
referenced by other documents:
-

-

-

Add the document title on the title page, in the footer, and in the document properties.
Revise the Rev number on the title page and in the header. Refer to the SFF TA TWG Process
Guide for information on document numbering.
Create all section headings; this allows the Table of Contents to correctly update upon completion.
o Click View > Check the box for Navigation Pane.
o Right click on headings in the Navigation Pane to add/ delete, promote/ demote headings.
Copy and paste content into the new document section by section (don’t forget the Abstract on
the cover page). Copying more than one section at a time will likely cause issues, particularly with
section headings. It is also recommended that tables and figures be copied over separately.
Add captions to tables and figures if not copied over (right click > Add caption; this allows lists of
figures and tables to updated without additional input from the editor).
Add/ remove/ revise content in Section 2 (References and Conventions) and Section 3 (Keywords,
Acronyms, and Definitions) as needed.
When creating references to figures, tables, and section headings in the document text, insert
linked references (ctrl + click follows the link). To insert linked references, click Cross-Reference
on the References tab, choose the appropriate reference, and click Insert.
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All text highlighted in yellow should be updated by the editor. Highlighted text is used to indicate
that the editor should provide information (such as a document title, revision number, abstract,
etc.) or that the editor should choose one of several listed options (e.g., if latching force or latched
mating force shall be tested per the performance requirements).
Update Table of Contents / Figures / Tables (ctrl + A, F9, click Update Entire Table for each dialogue
box that appears; make sure Track Changes is turned off for this step).

Once all content is copied into the template, the editor may choose to use the Track Changes feature as
content is revised. Update Revision History as needed.

2.8 Publishing Documents to PDF
When publishing a document to a PDF version:
-

For draft documents, add an entry to the Revision History for the new draft. For published
documents, condense the Revision History (refer to Section 2.3).
Remove line numbers and all Editor’s Notes (green text) from the document.
Update the Table of Contents / Figures/ Tables (with track changes turned OFF, Ctrl +A, F9, click
Update Entire Table for all dialogue boxes that appear).
Enable bookmarks using headings. This feature is enabled when saving. From the save menu,
change the file type to PDF, click Options and choose Create Bookmarks Using Headings.
Save the document as a PDF. NOTE: The same source file may be used to create a change bar
PDF and a clean PDF (if track changes was enabled during editing). When saving the PDF, toggle
the visibility of the changes from the Tracking bar on the Review tab.

2.9 Providing Documents to the SFF TA TWG Chair
For draft documents, the editor is required to provide the following to the SFF TA TWG Chair:
-

Source documents (e.g. Word versions) should be shared with the Chair for draft documents
At least one PDF of the draft document
NOTE: If a change bar version is to be shared with the SFF TA TWG, it is recommended that a
clean version also be provided. In this case, two PDFs should be provided to the Chair so that they
may both be shared.

For published documents, the editor is required to provide the following to the SFF TA TWG Chair:
-

One source document (e.g. Word version); all changes should be accepted within the source
document
One PDF version of the approved document

3 Connector Specifications
Connector specifications typically include the following:
•
•
•
•
•
•

General description
Pin numbering
Definition of datums
Connector/ cage/ module descriptions
Implementation guidelines (e.g. bezel opening, footprints, etc.)
Test requirements and methodologies

If additional sections are needed, they may be added where appropriate. If any of the sections listed above
are not needed, they may be omitted.
SFF TA TWG Editor’s Guide
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3.1 Guidelines for Mechanical Drawings
Mechanical drawings should be clear and easy to read. Drawings and text in drawings should be big enough
to be legible. Lines in figures should be thick enough such that they don’t disappear in PDF versions,
particularly when zooming in. Refer to the SFF TA TWG Style Guide for more information on formatting
figures in SFF TA TWG documents.

3.2 Guidelines for Test Requirements and Methodologies
SFF Connector Specifications typically identify certain performance requirements that are required to be
satisfied for compliance (e.g. durability, field life, field and storage temperatures, etc.). This information
serves as a product specification, as a test methodology, and as pass/fail criteria when validating the
connector performance. Performance criteria are typically self-certified by connector suppliers and are
summarized in Table 8-1 in the SFF Document Template (NOTE: the table number will likely change as the
template is modified).
Validation of the performance criteria listed in Table 8-1 is typically achieved by testing according to the
procedures described by EIA-364-1000. However, EIA-364-1000 leaves some test methods and other
options to be identified by the controlling document, which in this case, is the SFF Connector Specification.
Table 8-2 in the SFF Document Template identifies any test methods, test conditions, or testing thresholds
that are necessary to conduct testing per EIA-364-1000. Additional table entries may be added as needed.
Unneeded entries may be omitted.
If there are any other performance requirements that are validated outside of the EIA-364-1000 testing
suite (e.g. mating/ unmating force testing), they should be included in Table 8-3 of the SFF Document. The
editor is instructed to identify any industry documents and testing details that are needed to replicate
testing including test procedure, test method, test duration, load rates, pass/ fail criteria, etc.

3.3 EIA-364-1000 Testing Details
The following information is provided to complement the information provided in EIA-364-1000. Test
Groups 1, 2, and 3 are required of all connectors tested per EIA-364-1000. The additional information
captured in Table 8-1 of the SFF TA TWG Document Template dictates whether any of the four remaining
Test Groups require testing:
-

-

-

-

Plating type:
o Precious: Test Group 4 required (test options must be specified and recorded); Test Group
5 optional if < 0.38 microns of gold
o Non-precious: Include Test Group 5
Surface treatment:
o Lubricated: Test Group 6 required
(if lubricant is present, do not remove during sample preparation)
o Non-lubricated: Test Group 6 optional
Wipe length:
o Less than 0.127mm: Test Group 6 required
o Greater than 0.127mm: Test Group 6 optional
Durability cycles: Used to determine the number of cycles that a component is subjected during
durability and pre-conditioning tests
o Less than 50 cycles: Test Group 7 optional
o Greater than 50 cycles: Test Group 7 required

Some of the test procedures identified by EIA-364-1000 include options and pass/fail criteria that are
specified by the controlling document (e.g. the SFF TA TWG document). These tests are summarized in
SFF TA TWG Editor’s Guide
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Table 8-2 of the SFF TA TWG Document Template. The following information is provided to the editor for
reference:
EIA-364-1000 Tests:
-

-

-

Mechanical/ Physical Tests:
o Durability (also applies to Durability (Preconditioning)): A procedure to simulate the effects
of mating and unmating a connector system over its lifetime
▪ Number of durability cycles tested during EIA-364-1000 test sequences is
determined from the number of durability cycles expected throughout the
connector’s lifetime, which is listed in the controlling document (SFF document)
▪ Durability requirements may be listed separately for cage, connector, and module
(e.g. replace module after 50 cycles, continue testing cage and connector to 100
cycles)
▪ Editor to specify how testing is conducted (e.g. with cage, connector, and module;
with or without heatsinks; with latches engaged or disengaged)
▪ Refer to EIA-364-1000 for number of cycles required (Note: Fewer cycles are
required for preconditioning tests)
o Vibration: A procedure to test the integrity of a connector system design
Environmental Tests:
o Cyclic Temperature & Humidity: A procedure to determine the effect of high heat and
humidity on a connector
o Mixed Flowing Gas (MFG): A procedure to evaluate a connector by means of pore corrosion
in a corrosive environment; test option must be identified
o Dust Contamination: A procedure to evaluate the susceptibility of a connector to the effects
of dust accumulation at the separable interface.
o Temperature Life (also applies to Temperature Life (Preconditioning): A procedure to
evaluate a connector at elevated temperatures
▪ Field Temperature specified in the controlling document (SFF document) dictates
test conditions
▪ Refer to Table 8 in EIA-364-1000 for details on Temperature Life testing; refer to
Table 9 in EIA-364-1000 for details on Temperature Life (Preconditioning) testing
o Thermal Cycling (Disturbance): A procedure for a connector in an extreme condition;
intended to create small mechanical motions
o Thermal Shock: A procedure to test a connector in extreme conditions to simulate probable
storage, transportation, and application conditions
Electrical Tests:
o Low Level Contact Resistance (LLCR): A procedure to be used to specify pass/fail criteria
within a test sequence
▪ The first LLCR measurement in a Test Group is used to determine the baseline
measurement; there are no restrictions on the baseline measurement unless
otherwise noted in the controlling document (SFF document)
▪ Subsequent measurements in a Test Group are compared against the baseline;
subsequent measurements are required to be within the deviation from baseline
specified by the controlling document (SFF document)
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o

Dielectric Withstanding Voltage (DWV): A procedure to determine if contact spacing and
insulating material are adequate
▪ Unless otherwise specified, voltage applied during DWV testing should be 75% of
the minimum breakdown voltage
▪ Breakdown voltage is considered 3x greater than the operating rated voltage
specified by the controlling document (SFF document)

Any required performance metrics that fall outside of EIA-364-1000 are included in Table 8-3 of the SFF
Document Template. The following provides more information for tests that are commonly required of SFF
connectors; THIS IS NOT AN EXHAUSTIVE LIST.
Supplementary Tests:
-

Mechanical:
o Mating Force: A procedure to determine the amount of force needed to mate a module
with a connector when latches (if applicable) are deactivated (locked out or otherwise
removed)
▪ Editor to specify if testing is to be conducted with cage, connector, module, and/or
heat sinks
o Unmating Force: A procedure to determine the amount of force needed to separate a
module from a connector when latches (if applicable) are deactivated (locked out or
otherwise removed)
▪ Editor to specify if testing is to be conducted with cage, connector, module, and/or
heat sinks
o Latched Mating Force: A procedure to determine the amount of force needed to mate a
module with a connector with latches operational (latches not locked out)
▪ Editor to specify if testing is to be conducted with cage, connector, module, and/or
heat sinks
▪ Does not apply to connectors without latches; use Mating Force
o Latched Unmating Force: A procedure to determine the amount of force needed to
separate a module from a connector while releasing the latch mechanism (e.g. pull on pull
tab to deactivate latch and remove module from connector)
▪ Editor to specify if testing is to be conducted with cage, connector, module, and/or
heat sinks
▪ Does not apply to connectors without latches; use Unmating Force
o Latch Retention: A procedure to determine if the latching mechanism is able to withstand
the specified force (min or min and max); latches are to remain engaged throughout testing
o Cable Strain (Pull or Flex): A procedure to determine if the bulk cable is able to retain the
specified force before coming loose from the module shell
o Connector and/or Cage Retention: A procedure to determine if a connector and/or cage is
able to withstand the specified, vertical force without removing the connector and/or cage
from a host board
o Cable Flex: A procedure to determine if a bulk cable is able to withstand a defined number
of flex cycles when in use
o Cable Bend Radius: A procedure to determine if a bulk cable is able to withstand a defined
bend radius during use
o Tether Testing: A procedure to determine if a bulk cable is able to withstand a defined
amount of weight and flex when in use
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Environmental:
o Storage Temperature: A procedure to verify that a connector is capable of withstanding a
specified storage temperature
o Storage Humidity: A procedure to verify that a connector is capable of withstanding a
specified storage humidity
Electrical:
o Current: A procedure to verify that a connector is capable of carrying a specified current
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